How to Use GrandMaster Suite

Positions
# Table of Contents:

HOW TO USE GRANDMASTER SUITE - POSITIONS ................................................................................................................. 4

OVERVIEW .................................................................................................................................................................................. 4

WHEN SHOULD I USE POSITIONS? ........................................................................................................................................... 4

HOW DOES IT WORK IN GRANDMASTER SUITE? ................................................................................................................... 5

POSITIONS AND EARNINGS......................................................................................................................................................... 5

POSITIONS AND DISTRIBUTIONS............................................................................................................................................... 5

WORKING AT THE PAYROLL LEVEL ........................................................................................................................................ 5

CREATING POSITIONS................................................................................................................................................................. 6

TO CREATE A POSITION: .............................................................................................................................................................. 6

DEFINING POSITIONS TO USE EFFECTIVE DATES ....................................................................................................................... 8

TO SET A POSITION BY PAY DATE: .............................................................................................................................................. 8

ASSIGNING EARNING TABLES TO A POSITION ............................................................................................................................. 9

TO ASSIGN AN EARNING TABLE: .................................................................................................................................................. 9

ASSIGNING DISTRIBUTION TABLES TO A POSITION .................................................................................................................... 11

TO ASSIGN A DISTRIBUTION TABLE: ....................................................................................................................................... 11

ASSIGNING CLASSES TO A POSITION ......................................................................................................................................... 13

TO ASSIGN A CLASS: .................................................................................................................................................................... 13

ASSIGNING A POSITION TO A GROUP ......................................................................................................................................... 15

TO ASSIGN A POSITION TO A NEW GROUP: ................................................................................................................................. 15

TO ASSIGN A POSITION TO AN EXISTING GROUP: ....................................................................................................................... 18

ASSIGNING A Position TO A Deduction......................................................................................................................................... 19

ASSIGNING Positions TO A Wizard............................................................................................................................................... 19

TO ENABLE POSITIONS FOR USE WITH THE ADD EMPLOYEE WIZARD: .................................................................................. 19

ASSIGNING Rights TO A Position .................................................................................................................................................. 21

TO ASSIGN RIGHTS TO A POSITION: .......................................................................................................................................... 21

ALLOWING LOWER RATES THAN THE BASE RATE ...................................................................................................................... 23

TO ALLOW PAY RATES LOWER THAN THE BASE RATE: .............................................................................................................. 23

WORKING AT THE EMPLOYEE LEVEL ........................................................................................................................................ 23

ASSIGNING A Position TO AN Existing Employee...................................................................................................................... 24

TO ASSIGN A POSITION TO AN EXISTING EMPLOYEE: .................................................................................................................. 24

ASSIGNING A Position TO A New Employee ................................................................................................................................. 26

TO ASSIGN A POSITION TO A NEW EMPLOYEE USING THE WIZARD: ....................................................................................... 26

ASSIGNING A Position TO An Earning.......................................................................................................................................... 30

TO ASSIGN A POSITION TO AN EARNING: .................................................................................................................................. 30

TO ASSIGN A POSITION TO A SPLIT EARNING: ............................................................................................................................ 32

Distributing Earnings Across Departments ................................................................................................................................ 35

TO DISTRIBUTE EARNINGS ACROSS DEPARTMENTS: .................................................................................................................. 35
How to Use GrandMaster Suite - Positions

Overview

A Position is a record (commonly referred to as an object) that you define in GrandMaster Suite. Each Position record contains basic information that can be used to control salaries and rates, deductions, accumulators and distributions. If your payroll situation allows, Positions can control employee earnings so that you no longer need to access rates and distributions --these would become part of the payroll process through the Position settings.

Employees (paid according to default rate table)

"Production" Employees

Paid according to specific Rate Table

based on their Positional assignment

Positions can be assigned to an employee for record-keeping purposes only or can be used in situations where unionized employees maintain a position class and a specific pay rate.

When should I use Positions?

- You can use Positions when you need to assign a simple identifier to a group of employees. For example if Joe were classified as an employee who performs Administration duties, he could be assigned the Admin Position. Similarly, if Jane were classified as a Sales operative, she could be assigned the Sales position.

- Positions can be used when you need to control your payroll distribution table. For example, if your payroll routine calls for exception rates or exception distributions for a given employee, certain rates and distributions could occur automatically by specifying the appropriate Position when entering the employee's hours.

- Similarly, Positions can be used to control your payroll earning table.

- Positions can be used when you need to dictate a specific deduction amount. For example, if you have a union employee whose deductions are dependent on the task performed, the deduction could calculate according to the Position that has been assigned to the earning.
• When you want to simplify the process of setting up a new employee. For example, you could assign an earning table and distribution table to a certain Position, then have these items automatically applied to a new employee when you add them to the payroll.

• Positions can also be assigned to different employees by utilizing the employee template.

• When you want to resolve pay rates automatically. You can set up the earning search as Position rather than Earning. The Position Search would use the Position code as the primary qualification to resolve the pay rate.

• When you want to assign an employee rate that is lower than the employee's Base Rate. You could create a Position record that would allow for a pay rate that is lower than the employee's Base Rate.

• When you need to view positional information in certain reports. These reports include the cheque stub, transaction and customized payroll report, employee earning report and payroll earning report.

**How does it work in GrandMaster Suite?**

Positions can replace the task of setting up and assigning different rates, deductions or distributions when an employee changes positions or performs a different task within the pay period. The Journal Entry report will always reflect the correct G/L accounts even if the employee has performed a number of different duties within the pay period.

Each earning table that is assigned to a Position would represent a different earning scale or union along with a different distribution table. The earning table would have to be set up with the rates or salaries reflecting the proper amounts according to the agreement determined by the union. Each distribution table that is assigned to the Position could represent a different department or job.

If you are using the Position only as an information field, the only fields that you would need to set up would be the Code and Description -- start and end dates would not apply.

**Positions and Earnings**

A Position can act as a link to a specific Earning Table. This helps to ensure that the correct rate or salary is paid to a given employee. There are different methods you can use when setting up the Position to drive the earning table. Please refer to Online Help topics for more information about earning tables.

**Positions and Distributions**

A Position can act as a link to a specific Distribution Table. This can help to ensure that the earnings, deductions and benefits are properly allocated to the correct account numbers for the Journal Entry. Please refer to Online Help topics for more information about Distribution Tables.

**Working at the Payroll Level**

When you begin working with Positions, you must start at the payroll level. This is where you define the information for each Position such as its effective date, compensation settings, etc. Later on, once your Position is created, you can move to the employee level to assign it to each employee.
Creating Positions

Each Position record stores detailed information on how it is to be used during the payroll calculation process. Depending on your payroll requirements, Positions can be used for different purposes:

- **Informational Only** - You can use a Position to group employees under a certain class or to generate reports based on similar job types.
- **Payroll Processing** - You can use a Position to control the pay rate for any number of employees. This can be useful if you have a rate table with varying rates for each employee.

**TO CREATE A POSITION:**

1. With a payroll selected, choose the *Position Update* command from the *Payroll* menu. This opens the *Employee Positions* dialog box that displays a list of Positions in the current payroll.

   ![Employee Positions Dialog Box](image1.png)
   
   **Fig. 1**
   *The Employee Positions Dialog Box*

   **Note: Existing Positions** - This dialog box displays a list of all the available positions in your payroll. If you have used GrandMaster Suite for some time, there may be several positions to choose from. If you are new to GrandMaster Suite and are working through this guide for the first time, there will likely be no positions in the list.

2. Choose the *Insert* button and enter a unique name for the new Position in the *Position Code* field. Define a name that will help you identify this Position in the future. For example, if your Position is primarily for Production-based employees, you could name it "Production".

   ![Insert New Position Dialog Box](image2.png)
   
   **Fig. 2**
   *The Insert New Position Dialog Box with Name Added*

3. Click *OK* to assign the name to your new Position. This opens the *Position Update* dialog box where you can define the details for the new Position record.
4. Use the Description field to enter a brief description that will help you identify this Position in the future. For example, if your Position name is PRODUCTION, the description could read “Production area employees”.

5. If your Position is dependent on certain dates, enter these dates in the Start Date and End Date fields. Refer to the Defining Positions to use Effective Dates section of this lesson for further information.

   If your Position is to be used at all times, you do not need to enter any Start or End dates.

6. If this Position will be used in conjunction with a Class, place the cursor in the Class field and use the <F8> key to assign the desired Class record. Refer to the Assigning Classes to a Position section of this guide for further information.

7. If this Position will be used to apply a Rate Table, check the Override Earning Settings box, then place the cursor in the Earning Rate Table field and use the <F8> key to assign the desired Rate Table. Refer to the Assigning Earning Tables to a Position section of this lesson for further information.

Fig. 4
An Assigned Rate Table

8. If this Position will be used to apply a Distribution Table, place the cursor in the Distribution field and use the <F8> key to choose the desired Distribution Table from the list. Refer to the Defining Positions to use Effective Dates section of this lesson for further information.

9. Move to the FTE field and enter the default Full Time Equivalency rate for the Position.
10. If this Position will be used to apply a Pay Equity code, place the cursor in the *Equity Code* field and press `<F8>`. Similar to the preceding two steps, specify the Equity Code to be used for this Position.

11. Once you have completed the settings for this Position, choose the *Save* button close the dialog box. This returns you to the *Employee Positions* dialog box where your new Position is now listed.

![Image of Employee Positions dialog box](image1)

**Fig. 5**
The New Position Record

### Defining Positions to use Effective Dates

Position can be set up to work based on specific dates. This can be useful in situations where the Position record is to be used only on a temporary basis. For example, if a company won the bid on a new contract and all the positions are temporary you could utilize the Start/End dates to initialize then sever the positions. Once the end date is satisfied the Position would no longer be accessible.

This method requires two payroll-level settings.

**TO SET A POSITION BY PAY DATE:**

1. From the *Payroll Module*, choose the *Properties - Settings* command from the *File* menu.

![Image of Payroll Module](image2)

**Fig. 6**
The Properties - Settings Command
This opens the Settings dialog box.

2. Place a check in the Use Dated Positions for Pay Rate box then choose the OK button to apply the change.

![Fig. 7 The Setting Activated](image)

3. Choose the Position Update command from the Payroll menu to display the Employee Positions dialog box.

4. Double-click on the desired position, enter the appropriate dates in the Start Date and End Date fields, then click OK. Each time you use this Position GrandMaster Suite will verify that the date is valid before applying these settings.

**Note:** If your Position is to be used at all times, you do not need to enter any Start or End dates.

5. Click OK to close the dialog box and save the change. The Position will now operate based on the dates you specified.

**Assigning Earning Tables to a Position**

If you are using a Position to override the employees’ earning you need to specify the Earning Table that will be used. Depending on how your earning table is set up you may also need to assign a step or row to this Position.

**TO ASSIGN AN EARNING TABLE:**

1. With the Position Update dialog box open, place a check in the Override Earning Settings checkbox. This will require you to further define the earning table that will be used in place of the default earning.
2. To define the earning table, place the cursor in the *Earning Rate Table* field and press <F8>. This opens the *Global Earning Tables* dialog box that displays the existing earning tables available for use with this payroll.

![Earning Table Dialog Box](image)

**Fig. 8**
*The Global Earning Tables Dialog Box with 5 Available Earning Tables*

**Note:** If there are no available earning tables in the list, refer to the Online Help for more information on how to create an Earning Table.

3. Select the desired Earning Table from the list then click *OK* to apply it to the current Position. This closes the *Global Earning Tables* dialog box and adds the name to the *Earning Rate Table* field.
4. Enter the appropriate values in the Table Row and/or Step number fields that correspond to the assigned Rate Table.

5. Click OK to close the dialog box and save the change. The Position will now operate based on the settings you specified.

Assigning Distribution Tables to a Position

If you are using a Position to assign a Distribution Table to your employees, you can do so using the following instructions.

TO ASSIGN A DISTRIBUTION TABLE:

1. With the Position Update dialog box open, place the cursor in the Distribution field and press <F8>. This opens the Global Earning Tables dialog box that displays the existing earning tables available for use with this payroll.
Fig. 10
*The Distribution Tables Dialog Box with 1 Available Table*

**Note:** If there are no available Distribution Tables in the list, refer to the Online Help for more information on how to create a Distribution Table.

2. Select the desired Distribution Table from the list then click OK to apply it to the current Position. This closes the *Distribution Tables* dialog box and adds the name to the *Distribution* field.
Assigning Classes to a Position

The program allows you to define worker classes, based on sub-types of a given job. For example, you could use a class record to differentiate between a Class 1 or a Class 2 welder. If you have multiple Classes, you can set up a table with all of the classes for a given company.

If you are using a Position in conjunction with employee classes, you can do so using the following instructions.

TO ASSIGN A CLASS:

1. With the Position Update dialog box open, place the cursor in the Class field and press <F8>. This opens the Position Class dialog box that displays the existing classes available for use with this payroll.
2. Select the desired Class from the list then click OK to apply it to the current Position. This closes the Position Class dialog box and adds the name to the Class field.

---

**Fig. 13**
The Class Applied to the Position
Assigning a Position to a Group

Payroll Condition Groups allow you to specify certain conditions that an employee must meet before they can be included in a given calculation/report. Each time a Payroll Condition Group is loaded, GrandMaster Suite will check an employee to see if they meet the given criteria. If they do not, the employee is not loaded.

GrandMaster Suite allows you to assign a Position to a specific group of employees. One example where this feature can be used is when you need to create a report for employees that work at a specific Position.

TO ASSIGN A POSITION TO A NEW GROUP:

1. From the Payroll module, choose the New - Payroll Condition command from the Groups menu.

2. Enter a Group Code for the new group along with a brief Description that will help you to identify this group in the future.
3. Click on the Selects tab to access criteria settings for such items as Gender, Province, Template, Distribution, Default Positions and Payroll Categories.

- Template
- Distribution
• Default Positions
• Payroll Categories

For this lesson, we will only define one additional criteria -- the Default Positions.

4. Choose the Select Default Positions button to open the Report Multiple Position Selection dialog box. The list shows all of the available Positions that have defined for use in the payroll.

![Fig. 17](image)

*The List of Available Positions*

5. Select the desired Position from the list then click OK to close the dialog box. This returns you to the Selects tab. A text label now appears beside the Select Default Positions button indicating that a Position is now associated with this conditional group.

![Fig. 18](image)

*The Text Label Indicating an Associated Position*

6. Once you have completed the desired settings, choose the Save Group Conditions button. This stores the group information on disk for later use. Now that the group is saved you are ready to enable the group for the current payroll session ("current payroll session" refers to the time between loading a payroll until you close the payroll).
7. Choose the *Apply Group* button from the bottom of the *Payroll Condition Group Setup* window. This enables your Payroll Condition Group for the current payroll session and applies each of the settings you defined for the group.

Once the group has been applied, a message appears showing the number of employees that are included in the group, based on all of the defined conditions. This is a good way of verifying that you have entered your conditions correctly. If the number of employees does not seem right, simply go back through the four tabs and verify your conditions.

![Fig. 19](image1.png)
*A Message Showing 12 Employees in the Group*

**TO ASSIGN A POSITION TO AN EXISTING GROUP:**

1. From the *Payroll Module*, choose the *Groups - Open* command. This displays the *Open Group* dialog box that displays the available groups.

![Fig. 20](image2.png)
*The Group Enabled*
2. Choose the desired group from the list and select the *Modify* button (or choose the **File - Modify** command). This displays the *Payroll Condition Group* dialog box.

3. Choose the *Selects* tab and assign the desired Position (as outlined in Steps 3 through 7 of the previous section) then choose the *Save Group Conditions* button. This saves the group's updated information.

4. Close the dialog boxes to return to the *Payroll Module*. The information is updated and the group is automatically reloaded with the new settings.

For more information on setting up groups, please refer to the How To document entitled *Working with Groups*.

**Assigning a Position to a Deduction**

GrandMaster Suite allows you to assign a Position to a specific deduction, thus creating a link between the two items. This can be useful when you want the deduction to be triggered automatically based on an employee's Position.

For example, let's assume you have an employee who works at two different trades in a pay period and is committed to two different unions. If the Union deduction is calculated based on earnings, you could use the Positions feature to calculate the deduction based on the earnings that were entered to an exception Position.

Refer to the *Distributing Earnings Across Departments* section later in this document for more information on this topic.

**Assigning Positions to a Wizard**

GrandMaster Suite allows you to specify the options that are available to you when using the Add Employee Wizard. This is particularly useful if you always assign Positions to your employees as them to the payroll.

**TO ENABLE POSITIONS FOR USE WITH THE ADD EMPLOYEE WIZARD:**

1. From the *Payroll Module*, choose the **Employee - Wizard Settings** command. This displays the *Add Employee Wizard Settings* dialog box.
2. Choose the Dates/Base/Defaults tab and place a check in the Show Dates/Base/Defaults box. This enables the checkboxes that exist in this section. Each checkbox corresponds to a field that will be enabled or disabled when you are adding the employee using the wizard.

Notice that the Positions checkbox already contains a check by default (if it does not you should place a check in the box at this time).
3. Click OK to close the dialog box and return to the Payroll Module. The Wizard information is updated and the Position option will be available to you the next time you add an employee using the wizard.

![Fig. 24](image)

The Position Option Enabled in the Add Employee Wizard

### Assigning Rights to a Position

During the course of administering payrolls, you may find it necessary to enable or disabled the use of Position for certain payroll users. This can be accomplished through a setting in the Administration module.

#### TO ASSIGN RIGHTS TO A POSITION:

1. From the Administration Module, choose the Employee - Wizard Settings command. This displays the Add Employee Wizard Settings dialog box.

![Fig. 25](image)

The Update UserIDs Command Accesses the User ID Selection Dialog Box

2. Enter the Supervisor ID then click OK. This opens the User ID Update dialog box where you can view or modify the various options and modules that accessible by program users.
3. Choose the *Common* tab, move to the *Position* section then place a check beside each function you would like to have enabled. Removing the check from a box will disable the function for the user.

4. Once your settings are complete, choose the *OK* button to record the changes. The User ID information is updated and the corresponding functions will be enabled/disabled the next time you encounter a dialog box that uses the Position feature.
Allowing Lower Rates than the Base Rate

Under certain circumstances, you may find it necessary to assign a pay rate that is lower than the employee’s default. For example, let’s assume that you have an employee who is returning to his old Position after working as the acting foreman (at a higher pay rate). In such a case, you would need to enable the Allow Lower Position Pay Rates feature to ensure that the program allocates the correct pay amounts.

TO ALLOW PAY RATES LOWER THAN THE BASE RATE:

1. From the Payroll Module, choose the File - Properties - Settings command. This opens the GrandMaster Option Settings dialog box.
2. Place a check in the Allow Lower Position Pay Rates box then choose the Save button to apply the change.

![Fig. 28 The Setting Activated](image)

With this setting activated, each time an employee has a Base Rate assigned, the program will allow for a positional rate that is lower than the employee Base Rate.

Working at the Employee Level

The employee level is where you activate the Positions feature for your employee(s). Earlier at the Payroll level, you created a Position record. However, this Position record does not take effect for an employee until you apply it to them. Once activated, the employee-level Position settings will work in conjunction with the settings you defined earlier at the Payroll level.

The employee-specific data you require to work with Positions is accessed through the Payroll Specific Information dialog box.
Assigning a Position to an Existing Employee

GrandMaster Suite allows you to assign a Position to an employee at the time the employee is being added to the payroll or after they have already been added. This section discusses the latter.

TO ASSIGN A POSITION TO AN EXISTING EMPLOYEE:

1. Open the Employee Module and select the employee to which you would like to assign the Position. You can open an employee using the Employee - Open command or by choosing the Previous, Next or List Employee Icons until the desired employee’s name appears in the title bar.

2. Once the employee is selected, choose the Payroll Specific Info command from the Data menu.

This opens the Payroll Specific Information dialog box that allows you to define a wide variety of payroll-related data for the employee. For this lesson, we will only require the use of the Base/Default tab needed to assign the Position.
Fig. 31
*The Payroll Specific Information Dialog Box*

3. Choose the *Base/Default* tab then place the cursor in the *Position* field and press <F8>. This opens the *Employee Positions* dialog box that displays the existing Positions available for use with this payroll.

Fig. 32
*The Employee Positions Dialog Box with 1 Available Position*

**Note:** If there are no available Positions in the list, refer to the Online Help for more information on how to create a Position.
4. Select the desired Position from the list then click OK to apply it to the employee. This closes the Employee Positions dialog box and adds the name to the Position field. The text label beside the Position field also updates to show the name of the selected Position.

![Fig. 33](image)
The Position Applied to the Employee

5. Click OK to apply the change and you are returned to the Employee Module.

Assigning a Position to a New Employee

GrandMaster Suite allows you to assign a Position to an employee at the time the employee is being added to the payroll or after they have already been added. This section discusses how to assign a Position while adding the employee to the payroll for the first time.

In order to use this method, you must have already performed several steps:

- **Creating a Position** - A Position record must exist before it can be added to an employee. This must be done at the payroll level. View the Creating Positions section of this guide for more information.

- **Assigning Position to a Wizard** - If you are using the Add Employee Wizard to add your employees to the payroll, you must have this functionality enabled in the Wizard settings. This must be done at the payroll level. View the Assigning Position to a Wizard section of this guide for more information.

TO ASSIGN A POSITION TO A NEW EMPLOYEE USING THE WIZARD:

1. With a payroll selected, choose the Add Employee command from the Employee menu. This displays the Employee Name Selection dialog box.
Enter the name of the new employee in the Name field. Enter the surname first, followed by the given name (e.g. Smith Joe). If you think the employee may already exist in the payroll, enter the first few characters of the name then choose the List button to view employees who have a similarly spelled name.

3. Once the name is entered, choose the Add button. This closes the dialog box and displays the Employee Information dialog box where you can add detailed information about the employee.
4. Move through each of the six tabs completing the information as required. Certain fields require a value while other fields are optional in nature.

5. Once you have completed the information in each tab, choose the OK button. This closes the Employee Information dialog box and returns you to the Employee Name Selection dialog box. You will notice that the title of this dialog box has changed to an instructional line that states Select "Continue" to Add Employee to payroll or "Add" to add another to registry.

![Fig. 36](Image)
The Updated Dialog Box

- If you choose Continue, you will move forward in the employee creation process (which is what this particular lesson requires).
- If you choose Add, you will be given the opportunity of adding more employees to the registry. You would then need to add them to the payroll at a later time.

6. Choose the Continue button to proceed with adding the employee to the payroll. This displays the Add Employee to Payroll dialog box.

![Image](Image)
The Add Employee to Payroll Dialog Box

7. Complete the required information then click OK. This completes the preliminary data entry steps and displays the first step in the Add Employee Wizard.
8. Proceed through each step completing the information for each field as required. Once you reach Step 3 you will be presented with the option to assign a Position for this new employee.

9. Place the cursor in the Position field and use the <F8> key to choose the desired Position from the list. If no Positions appear in the list, refer to the Creating Positions section of this guide for more information.
10. Proceed through the remaining Wizard steps to complete the Add Employee process.

Assigning a Position to an Earning

GrandMaster Suite allows you to assign Positions to individual earnings that have been applied to an employee. This is useful in such cases when you want to enable the distribution of earnings (e.g. if the employee’s responsibilities are split between different departments and their salary needed to be allocated accordingly). Assigning a Position to a particular earning forces a specific distribution to that earning.

The first part of this section will discuss how to assign a Position to an earning. The second part will discuss how to assign a Position to a split earning for cost allocation purposes.

TO ASSIGN A POSITION TO AN EARNING:

1. Open the Employee Module and select the employee to which you would like to assign the Position. You can open an employee using the Employee - Open command or by choosing the Previous, Next or List Employee Icons until the desired employee's name appears in the title bar.

2. Once the employee is selected, choose the Earnings command from the Data menu.
This opens the Earnings dialog box that allows you view or modify the earnings for the selected employee.

3. Highlight the desired earning in the list then choose the Edit button to open the Employee Earning Details dialog box. This is where you specify the details for the earning.

4. Place the cursor in the Position field and use the <F8> key to choose the desired Position from the list. If no Positions appear in the list, refer to the Creating Positions section of this guide for more information.
5. Click **OK** to close the dialog box and return to the **Earning** dialog box. Notice that the earning row has been updated to include the name of the Position right after the earning name.

**Fig. 43**

*The Position Assigned*

**Fig. 44**

*The Updated Earning Information*

You have now assigned a Position to an earning. The next section describes how to assign a Position to an earning that is split.

**TO ASSIGN A POSITION TO A SPLIT EARNING:**

1. Open the **Employee Module** and select the employee to which you would like to assign the Position.

2. Once the employee is selected, choose the **Earnings** command from the **Data** menu. This opens the **Earnings** dialog box that allows you view or modify the earnings for the selected employee.
3. Highlight the desired earning in the list then choose the Duplicate button. This creates an exact copy of the selected earning and opens the Employee Update Earning dialog box so you can modify its settings.

4. Place the cursor in the Position field and use the <F8> key to choose the new Position from the list.
5. Click **OK** to close the dialog box and return to the *Earning* dialog box. Notice that a new earning row has been added. The earning has the same name as its original counterpart, but the Position label reads differently (in our example it now reads **Production**).

You have now assigned a Position to a split earning.
**Distributing Earnings Across Departments**

Assigning positions to an employee allows you much flexibility when working with varying employee work habits. For example, lets assume you have an Hourly employee who works sporadically in several different areas or departments. If these areas and departments have different distribution pay scales the change in position can initiate a change to the distribution and to the earning table -- thus providing the hours with a new rate. This method of splitting earnings allows for the costing of hours to different distributions or departments and the conversion of the rates according to the table.

**TO DISTRIBUTE EARNINGS ACROSS DEPARTMENTS:**

1. Select an employee then open the *Payroll Specific Information* dialog box.
2. Select the *Base/Default* tab, place the cursor in the *Position*, then and press `<F8>`.
3. Select a Position from the list then accept and close the dialog boxes. You have now linked the employee with an earning code.

You can assign the position to the hours worked when keying in the hours. This would be necessary if the employee works as a carpenter and a plumber and has to remit to both of these unions. Each union deduction would be set up as a *Percent of Earnings*. The employee’s rates are different depending on the job he performs and his earnings and benefits should be allocated to an alternate distribution table.

For example:

- The carpenter’s union is 4% of the employee’s earnings and the carpenter’s rate is 25.00 an hour. These earnings, deductions and benefits should be assigned to the GL account numbers allocated to the carpenter’s distribution.
- The plumber’s union is 3% of the employee’s earnings and the plumber’s rate is 30.00 an hour. These earnings, deductions and benefits should be assigned to the GL account numbers allocated to the plumber’s distribution.

The employee worked 25 hours as a carpenter and 30 hours as a plumber.

The hours worked as carpenter with the carpenter Position and the hours worked as a plumber are keyed with a plumber’s Position. The *Rate* box will automatically be populated by the rate from the earning table assigned to the Position and the *Distribution* box will also be populated by the distribution set up on the Position.

The carpenter’s deduction is assigned a specific position at the payroll level under the *Selection* tab. The plumber’s deduction is also assigned a specific position at the payroll level under the *Selection* tab.

The carpenter’s union is a deduction using the position assigned to the carpenter’s deduction.

- \[ 25.00 \times 25.00 = 625.00 \times 4\% = 25.00 \] The deduction made to the carpenter’s union would be 25.00.

The plumber’s union is a deduction using the position assigned to the plumber’s deduction.

- \[ 30.00 \times 30.00 = 900.00 \times 3\% = 27.00 \] The deduction made to the plumber’s union would be 27.00.